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President’s Corner
Happy New Year to all my camera club friends. As I
write this the weather outside is gray and gloomy, but
it’s a perfect day to stay indoors to watch the Seahawks
crush the Panthers! (Unless of course, you have tickets
to the game.) Go Hawks!
January is almost half over by the time this newsletter comes to you. On the
10th we completed the compilation of the club’s Annual photo books. Twenty
five members contributed their photos to complete the books. If you didn’t
participate, I hope you get a chance to see one of the other member’s books, and
maybe next year your photo will be included.
We’ve started our Fifty Two Week Challenge and we’re now 2 weeks into the
project - see details further in the newsletter. I feel we may have gotten off to a
bit of slow start, but so far the Flickr Group has 14 members and I expect there
will be more as we move along. It’s never too late to join.
We have some great learning opportunities coming up this month with the
Fundamentals and Advanced Groups as well as a special guest speaker at the
General Meeting. On the 24th Frank will be leading us on another great field
trip to see an Elk feeding station. So as you can see, even though it’s the middle
of winter, there’s still lots going on with the camera club. Read further in the
newsletter for details on all these activities.
And don’t forget, we can’t keep providing these great leaning and hands on
opportunities without your support. Your membership dues are due on January
31st so if you haven’t already paid them, please visit the membership page of
our website for details on how to get current with your dues.
Happy Trails,
Colleen Easley
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Olympia Camera Club Board Minutes
January 6, 2015 @ 6:30 p.m.
Mekong Restaurant, Olympia
Persons Present: President Colleen Easley, Vice
President Gary Wells, Secretary Judy Mason,
Treasurer John Damito, Rosalind Phillips, Teri
Dean, Jodi Cox, Wes Kirkpatrick, Terri and Frank
Townsend, Scott Wood, Linda Foss, Chris
Weinreich, Gene Pardee, Bruce Livingston, John
Gerecht
Minutes: Teri Dean moved and Gary Wells
seconded that the minutes be accepted as they
appeared in the Newsletter. The motion was
approved.
Treasurers Report:

Starting Balance (12/1/14) $1,266.60
DEPOSITS
Dues
$290.00
Total Deposits
+ $290.00
EXPENSES
Adobe PS CC
$10.87
Website Services $450.00
NWCCC
$20.00
Total Expenses
Ending Balance

-$480.87
$1,075.73

----------------------------------

Savings Balance
Starting Balance
Divident Interest
Ending Balance

$1,380.56
.12
$1,380.68

President's Report:
Colleen reported that 42 people attended our
awesome holiday party. The OCC Facebook site
continues to get new additions that include many
younger people. The Word of the Week got under
way last Friday. Only OCC members may post
images on the club Flickr site. Colleen asked that by
March OCC officers, group leaders and
chairpersons need to submit a summary of the
procedures they follow to do their jobs as a helpful
guide for future leadership.

Calendar: Persons writing about forthcoming
activities for the Newsletter should also post events
on the Club Calendar.
Community Liaison: Wes Kirkpatrick read a thank
you note from the Love Our Local Fest organizers
who have invited OCC to participate again next
year. The Capitol Land Trust will hold a breakfast
at 7:00am on February 10th, 2014 at the Marcus
Pavilion at St. Martins College. Wes will inquire
whether photo support by our membership is
needed.
General Mtg (6:30pm on the 4th Tuesday of each
month in Pod A at Capital High School:) Gary
Wells reminded the Board that Dennis
Brockschmidt is the featured speaker on January 27.
John Cornicello will address the group on February
24th. John will be talk about the use of lenses.
Advanced Group (6:30pm on the 3rd Tuesday of
each month at Edge Lake Mobile Home Park in
Lacey:) Scott Woods announced that January's
meeting will be a round table discussion about new
equipment, gadgets and other photography related
topics. If members so wish they may bring no more
than 2 holiday related images to share. The
February Advanced Group meeting will be a yet to
be determined hands on work shop.
Fundamentals Group (6:30pm on the 2nd Tuesday
of each month in Pod A at Capital High School:) In
January we will view 2 Field Trip portions of Frans
Lanting's Creative Live Seminar. Landscape
photography will be the focus. In February our own
Charis Wilson will speak about her journey to
becoming a soccer photographer.
Newsletter: The updated, correct e-mail address for
submitting Newsletter articles is on the back page of
the Newsletter.
Webmaster: Group leaders can list meeting notices
as events on the OCC Facebook page.
Social Programs/Field Trips: 25 people registered
to participate in the OCC Annual Publishing Party
Saturday, January 10th. An all day field trip to the
Oak Creek Wildlife Refuge is scheduled for
Saturday, January 24th.
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Scavenger Hunt/Dinner: Linda Foss will make
reservations at the River's Edge Restaurant in
Tumwater for June 23rd, 2015.
Membership: New members are Meredith
Rafferty, Barbara Craven, Larry Mallo and Jeff
Willson.
There was nothing new to report about the
NWCCC, NPPNW or PSA. Dale Easley is helping
wrap up this year's traveling print project. The
final viewing/voting opportunity will b at the
Fundamentals Group Mtg. in January.
Thurston Co. Fair: Colleen requested that the Fair
committee (Colleen, Frank Townsend, Gary Wells
and John Gerecht) schedule a follow-up mtg. soon.
Old Business: The financial benefits of purchasing
a year of Photoshop/Lightroom CC on an Amazon
Gold Box Special vs. continuing our monthly
$10.87 subscription were discussed, as well as
whether we are using the program enough at
meetings to warrant the expense. It was concluded
that some presenters may still need to use the club
computer with these program features when they
speak to our membership.
New Business:
Several options for displaying OCC members'
photography in gallery type settings were explored.
These included hanging members' work on the
cafeteria walls at the Dept. of Corrections in
Tumwater sometime this spring, having a OCC
showing somewhere at Arts Walk in downtown
Olympia the first weekend in October, and
participating in an OCC exclusive opening and
month long show at a gallery in Taylor Town this
May. Chris Weinreich, who had made the contact
and inquiry about the Taylor Town Gallery,
presented the pros and cons of this option. Much
discussion ensued about the personal expense and
photo quality required for a gallery showing and
ways the Fundamental and Advanced Groups' up
coming programs might pave the way so that any
member who wanted to participate could be ready
by fall. Gene Pardee moved and Gary Wells
seconded a motion that we table the Taylor Town
opportunity for now and possibly revisit it at a later
date, which the majority of the board approved.

Gary Wells made several suggestions about
activities to consider for future planning. Among his
ideas were having the OCC sponsor Saturday or
Sunday
quarterly
photography
workshops,
beginning to advertise the photography at the
Thurston Co. Fair early in places like frame shops
in order to generate greater community
participation, and becoming involved in more
community service, such as offering to take photos
of Nursing Home/Retirement residents. Gary Wells
and Linda Foss will gather more information about
the feasibility of the latter.
John Gerecht stated that participation in the Micro
Computer Digital Imaging Group (OMUG) he hosts
the second Monday of every month at Capital High
School has dwindled. He requested that the OCC
consider assuming sponsorship of his group for the
purpose of generating wider publicity about its
existence and happenings. Concern was expressed
about some differences between John's group and
ours and how these would be dealt with if the two
groups were blended. Scott Woods moved that we
table this discussion so that the pros and cons could
be explored more thoroughly. Gene Pardee
seconded the motion, which was then approved by
the board.
Members may look in the OCC Member Sharing
Dropbox to see a list of camera equipment, framing
materials, etc. the wife of a man with dementia
would like to sell since they need to downsize and
relocate. Dale and Colleen Easley have moved the
items to their house. The pricing has been left to us,
so a member's best offer might well stand.
Gene Pardee moved that the meeting adjourn at
8:30 pm. Gary Wells seconded the motion. The
motion was approved.
Respectfully submitted,
Judy Mason, Secretary
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Fundamentals Meeting
January 13, 2015 @ 6:30 p.m.
Capital High School—Pod A
This month we will be watching and discussing the field trip portion of the Frans Lanting course taught in
November on creative live. This excellent segment has some great tips on how to adjust composition and
exposure when shooting wildlife from a confined position. Frans Lanting is an award winning National
Geographic photographer whose work focuses on sharing his passion about the natural world. Bring your
favorite wildlife/landscape tips along with a favorite piece of equipment for show and tell.
In February, Charis Wilson will take us through her journey as she has learned how to take sharp action
photos of the Sounders. She will be discussing her exposure, composition, and equipment lessons learned
and where she hopes to go in the future.

Advanced Photography Group
January 20, 2015 @ 6:30 p.m.
Edge Lake Community Center
The Advanced Photography Group picks back up this month after taking a break in December for the annual
OCC Holiday Party. At this months meeting we will be having a photographic roundtable. Perhaps you got
some new gear over the holidays and you have questions about it. Maybe you are considering a new gear
purchase and you would like advice from other photographers, or maybe you have questions about the art
and craft of photography and workflow? No photographic topic will be off limits.
For this months photo-sharing segment we are asking that you bring no more than 2 holiday themed images.
This could be anything from Halloween through the New Year. While we encourage prints, you have more
control as to how they are presented, we will accept digital images.
As always, the Advanced Photography Group meets at the Edge Lake Mobile Home Park Community
Center at 3928 21st Ave. SE in Lacey. The meeting runs from 6:30pm until 8:30pm and we look forward to
seeing you.

General Club Meeting
January 27, 2015 @ 6:30 p.m.
Capital High School—Pod A
Guest Speaker: Dennis Brockschmidt
Dennis was a U.S. Navy photographer from 1968-1988, and served two tours in Vietnam. He worked on
development of the Space Shuttle, the NASA Viking Project (first Mars lander), and the USAF B1 Bomber
escape system. Dennis also worked as a photographer for Penn-Daniels, Inc. in their advertising
department. He has been a Registered Nurse for the last 20 years, mostly in psychiatric hospitals, but
continues working as a freelance photographer. His portfolio includes landscape, portrait, aircraft, wildlife,
nudes, birds, close-up, military, HDR photography and more.
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VIEW ELK FEEDING!
by Frank Townsend

Set Saturday, January 24 aside for a trip over White Pass to
view (and photograph) hundreds of Elk at the Oak Creek
Wildlife feeding station. The Oak Creek Wildlife Area covers
64,200 acres in Yakima and Kittitas counties, about 15
miles northwest of Yakima. The Washington Department of
Fish and Wildlife (WDFW) first acquired land in the area in
1940 to provide a home for the growing Yakima elk herd that
was conflicting with private landowners, orchard growers and livestock producers. The area now has a
winter feeding program that has helped to reduce damage to agricultural lands and also provides a great
opportunity to see elk up close. A second nearby site is used as a feeding station for Big Horn Sheep.
We are planning to leave from the Cooper Point Landing parking lot, near 5 Guys Burgers on Cooper Point
Road at 7:30 AM for the drive over White Pass (Highway 12). Hopefully we will arrive early enough for
the Big Horn Sheep feeding, then we will move to the Elk Station. We may be able to ride in one of their
trucks into the center of the field while the animals are present. Each car in the caravan should have the
Washington Discovery Pass and by law must carry tire chains when traveling Washington State
passes. Bring along a light lunch or snack, we will make a dinner stop on the way home.
NOTE: The photographer of the elk image is unknown. Image was imported from a Microsoft Publisher clip art file.

National Geographic Live: Brian Skerry
Friday, January 30, 2015
The Washington Center
7:30 p.m.
The National Geographic series returns to the Washington Center with photojournalist and marine
conservationist Brian Skerry. Skerry's award winning underwater photography shows us the mystery of our
ocean's depths. Skerry’s powerful presentations showcase award-winning imagery and thrilling wildlife
encounters, inspire reverence for the marine realm, and offer hope for protecting the vitality of our world’s
oceans.
Tickets are available here: http://bit.ly/brianskerrytickets

Page - 6- Issue 1, January, 2015 - Shutterbug Times Volume 80

Living the Club Motto
by Colleen Easley

Photographers Helping Other Photographers and our Community since 1936 has long been our motto and I
think we’ve done a pretty good job of it over the years. Last month brought a new opportunity to help a
fellow photographer who wasn’t even a member of our club. I got an email through the club’s website from
Linda Albro. Her husband is a long time photographer, but is now suffering from dementia. His medical
condition has forced major financial changes in their lives. Instead of enjoying their golden years in their
dream retirement home, they were forced to short sale their house and move into a fifth wheel trailer on her
daughter’s property. Linda’s husband had a bunch of old photography stuff she needed to get rid of before
she moved so she wrote me asking for help. Dale and I went out to her house in Lacey and loaded up our
car twice with tons of miscellaneous stuff. There are a lot of framing supplies, a fair amount of photo paper,
a couple mat cutters - both missing pieces, tripods, monopod, heads, filters and other misc items. I told her I
had no guarantee we could sell any of it and she was ok with that. She just wants the stuff to go to someone
who can use it. I’ve put a list of what we have in DropBox so if you’re interested, please take a look, and
give me a call if you’re interested in anything. Items will go first come, first served. We don’t have set
prices for any of it, but would appreciate if you’d consider Linda’s situation and offer a small donation for
what you think things are worth to you. Here is the link to the document in the DropBox.
https://www.dropbox.com/s/1klnpl1j1ui0ahx/Linda-Photo-Gear.pdf?dl=0
Call me if you would like to come over to see anything.
Colleen - 360-956-9127

Membership Dues
by Colleen Easley

It’s that time of year that we ask member’s to renew their Olympia Camera Club memberships. For 2015
dues remain a bargain at just $20 per individual and $35 per couple. We also offer a student rate of just $15.
There are three ways you can pay your dues.
1. Give your dues to our Treasurer (or any other officer) at any of our January meetings.
2. Mail your check to Olympia Camera Club - PO Box 13333, Olympia, WA 98508
3. Use the PayPal link on the Membership page of the club’s website. (Note: dues are slightly higher when
paid via PayPal in order to cover our PayPal fees)
We encourage your renewal as soon as possible so we can generate a reasonably accurate budget for 2015.
In order to maintain your membership status and access to the website Member’s Only Area, your dues are
payable by January 31, 2015.
Thank you for your support.
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Spice up your Photography with Equipment Rentals
By Rosalind Philips

Camera equipment is expensive and takes up a lot of space in your home. Equipment rental is a great way to
deal with restricted budgets and space. I rent equipment for two reasons; special occasions and testing
equipment for purchase.
I consider a special occasion anytime I want to something special. For example suppose I want to do a
hummingbird photo essay. I might rent lots of speed lights, stands and some transceivers/receivers so that I
can light the birds and really stop the action. Or perhaps I am shooting a wedding and need an extra camera
body. My recent experiments with a Tilt-Shift lens involved a rental. The other reason I rent equipment is to
test out something I want to buy. Last January I rented a Canon 5D Mark III to see how it felt in my hands
and whether it worked for my style of photography. It did and then the 7D Mark II came out. So I have
changed my mind. Renting equipment before you buy can save you from costly mistakes.
I rent from two companies, LensRental.com (http://www.lensrentals.com) and BorrowLenses.com
(http://www.borrowlenses.com). Both companies are good; they do not charge your credit card until the
lens ships, you can purchase insurance, and you can make reservations. I tend to prefer LensRental because
they have more variety (they have IR cameras) and I think the insurance policy is a little better. Both
companies will let you take the equipment out of the US; shipping is only within the US. There are lots of
other companies that do rentals and you might find lower prices. Glazers in Seattle does do rentals, but they
require a security deposit and you have to go up to Seattle to pick-up and return.
So, shake up your equipment doldrums and start renting.

PHOTOTUNITIES
A listing of events of visual interest for Olympia Camera Club members
Jan. 16–25 Chelan
Lake Chelan Winterfest
Chelan transforms into a winter paradise for this two-weekend event featuring an outdoor ice-sculpture
gallery, horse-carriage rides through downtown, snow sports, beach bonfires and an ice bar; the festival adds
midweek activities this year, too. 800.424.3526, lakechelanwinterfest.com
Jan. 17 Conconully
Outhouse Races
In one of the state's quirkiest races, contestants mount wooden outhouses on skis and push them down a
snow-covered Main Street. 877.826.9050, conconully.com
Through Jan. 25 Concrete, Rockport, Marblemount
Skagit Eagle Festival
This free celebration on Saturdays and Sundays during eagle-watching season along the Skagit River
includes tours, walks and educational programs. 360.853.8784, concrete-wa.com
http://www.aaawashingtonjourney.com/events/index.asp
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Fifty Two Week Challenge
by Colleen Easley

For 2015 the club is doing a 52 week photo challenge. There will be a theme word emailed to members at
midnight every Friday night starting January 2nd, so you’ll have Saturday through the next Friday to take a
photo that represents the theme and then post it to our 2015 Challenge GROUP on Flickr at
https://www.flickr.com/groups/2015-challenge/ If you choose to take the challenge, please join the group
now. You may post one image per word and title it with the theme word it represents. A list of past words
is maintained on the club’s website under ACTIVITIES in case you want to get caught up.
This is not a competition. It is just something fun to do every week and it also tests your creative thinking
and imagination. Your participation is completely optional, and if you miss a week or two, no one’s going to
scold you, but I think you’ll enjoy challenging yourself each week. You can use any camera you
wish - even your cell phone. Just try to post to the Flickr Group in the week that the word is in effect. By
the end of the year, we should have a pretty nice collection of images!
If you don’t have a Flickr account but want to participate, please consider signing up for one at Flickr.com.
There is a tutorial for you to download here: http://www.olympiacameraclub.org/wp-content/
uploads/2014/01/How-to-Use-Flickr.pdf
I hope you’ll join other OCC members and have fun with the challenge, but if you don’t want to participate
and you’d rather be removed from the Word of the Week (WOW) emails, just send a request to be removed
from the WOW emails to olympiacameraclub@gmail.com and we’ll take your name off that list.
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Ask Tim Grey
Question
I want to export a Lightroom catalog from one computer to another. Will the exported catalog merge with the
existing one or replace it? I want to merge them and not lose any file or photo in either one of the catalogs.
Tim's Answer:
When you export a catalog from Lightroom, you will have a separate catalog file that will not be automatically
merged with any other catalog. However, it is quite easy to merge two catalogs into a single catalog in Lightroom.
The result will be a single catalog that contains all of the photos and information from both of the catalogs you merge
together.
The process I recommend involves first exporting the catalog you want to merge into another catalog, and then
importing that catalog into your "master" catalog. This approach is not necessarily the most efficient method (since it
involves making an additional copy of your catalog and photos, which might not be necessary), but it is an approach
that helps reduce the risk of mistakes.
First, open the catalog you want to merge into your master catalog, and select the photos you want to export. You
might, for example, choose "All Photographs" from the Catalog section of the left panel in the Library module, and
then choose Edit > Select All from the menu so that every image in the catalog is selected. Then choose File > Export
as Catalog from the menu to bring up the Export as Catalog dialog.
I recommend using an external hard drive as the destination of the export operation, which makes it easy to make the
catalog and photos from the "source" catalog available on the computer where your "master" catalog is stored. Specify
a name for the exported catalog, using a name that will make it obvious what this catalog is being used for, such as
"Catalog from Italy Trip to Merge with Master Catalog". Also be sure the "Export negative files" checkbox is turned
on, so your photos will be copied along with the catalog. You can also choose the option to "Include available
previews" and "Build/Include Smart Previews" if you'd like to copy those files to the destination as well. When you
have established the settings for the export, click the Export Catalog button at the bottom-right of the Export as
Catalog dialog to begin the process of copying the catalog and photos.
When the process is complete, the external hard drive you used for exporting the catalog can be connected to the
computer where your master catalog is stored. Launch Lightroom and open the master catalog (if it isn't opened by
default) and choose File > Import from Another Catalog from the menu. Navigate to the folder where you exported
the source catalog, and select the "lrcat" file and click the Choose button.
In the "Import from Catalog" dialog you can make sure that the checkbox is turned on for the "All Folders" option, so
all exported folders will be imported into your master catalog. Choose the "Copy new photos to a new location and
import" option from the File Handling popup, and then click the Choose button to bring up the Choose Folder dialog.
Navigate to the top-level location where you want to save all folders, such as the external hard drive you use to store
all of the photos contained in the master catalog, and then click the Choose button to set that location as the
destination. Then click the Import button to being the process of importing your exported photos into your master
catalog.
The result, once again, will be that your master catalog now includes the photos you exported from the source catalog,
along with all of the information you updated in the source catalog. At this point, once you have updated your backup
of your photo storage and master catalog, you can discard the photos and catalog that were the source of your merge
operation.

Tim Grey's articles are reprinted with permission. You can subscribe to the free Ask Tim Grey
eNewsletter at AskTimGrey.com
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January 2015
Olympia Camera Club Monthly Meetings
The Fundamentals of Photography Group
Monthly on the Second Tuesday of the Month
Capital High School—POD A
January 13, 2015 from 6:30pm to 8:30pm
Meeting Topic: field trip portion of the Frans Lanting course taught on
creative live.
Contact, Rosalind Philips, Fundamentals Chair

The Advanced Photographers Group (APG)
Monthly on the Third Tuesday of the Month
January 20, 2015 from 6:30pm to 8:30pm
Edge Lake Mobile Home Park - Community Center, 3928 21st Ave SE, Lacey
Meeting Topic: Photographic Roundtable; For this months photo-sharing segment: 2 holiday
themed images. This could be anything from Halloween through the New Year.
Contact, Scott Wood, APG Chair

Koffee Klatch Meet up, Every Other Wednesday Morning
from 9:00 am to 11:00 am
Panera’s Bakery, 2525 Capitol Mall Drive SW, Westside of Olympia
Open discussions about photography and other topics of interest.
Contact, Wes Kirkpatrick, Klatch Chair

General Meeting
Monthly on the Fourth Tuesday of the Month
January 27, 2015 from 6:30pm to 8:30pm

Dennis Brockschmidt former Navy photographer is the featured
speaker.
Contact, Contact, Colleen Easley, President

Monthly Business Meeting, First Tuesday of the Month
February 3, 2015, from 6:30 pm to 7:30 pm
Meeting at Casa Mia (Downtown Olympia)
Open to all. Join us before the meeting for dinner at 6:00 pm if you would like.
Contact, Colleen Easley, President
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Olympia Camera Club
PO Box 13333
Olympia, WA 98508-3333
Memberships with

Committee Chairs
Community Liaison
Wes Kirkpatrick

Advanced Photography Group
Scott Wood

Fundamentals of Photography
Rosalind Philips

Equipment Custodian
Gene Pardee

Newsletter Editor
Teri Dean

NWCCC Liaison
Wes Kirkpatrick

NWCCC Traveling Prints
Dale Easley

PSA Representative
Frank Townsend

Scavenger Hunt
Rosalind Philips

Social Programs
Frank Townsend

Thurston County Fair
Terri Townsend

Webmaster
Colleen Easley

